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About 
This is a quick introduction for understanding the Mizu Callcenter platform. 
 
The Mizu Callcenter is based on the MizuManage with the addition of the following functionalities and modules: 

 A new type of users called “operators” (these are mostly the same as VoIP endusers with a few additional properties 
like assigned campaign and they are treated specially by the mizu server) 

 Campaign: you can run different campaigns simultaneously (with different business logic, different settings, scripts, 
GUI, clients and operators) 

 MAgent: client application for the operators. Traditional callcenters use a standard voip client (softphone or hardware 
phone) and usually a separate web based CRM frontend. The MAgent client application has all these integrated in a 
single application allowing easier usage and control. 

 MAgentLite: if you wish to keep your old CRM (more details below) 
 GUI: supervisors can create a different user interface for each campaign by using the “GUI designer” form from the 

MManage application. This will be visible for the agent on the Questionnaire form (from the MAgent application) 
 Script: each campaign can have different business logic. This can be defined using the “Script” form from the 

MManage 
 Callcenter statistics: statistics by campaign or agent (available phone numbers, total calls, “successful” calls, agent 

work time, etc) 
 Predictive dialer: a server side dialer to automatically dial the phone numbers based on the available agents and 

previous statistics history. The purpose is to reduce the operator wait time to the minimum by eliminating connect 
and ring times. 

 

Terms 
Callcenters: http://en.wikipedia.org/wiki/Call_centre 

Outbound callcenter: Operators will call clients (phone numbers) for example to sell something 

Inbound callcenter: Clients calls to operators. Calls are handled by IVR.  For example: receptionists 

Operators: People working as agents 

Clients: Called people in case of outbound callcenter or caller people in case of inbound callcenter 

CRM: database backed (callcenter specific tables and stored procedures) and frontend (MizuManage and MAgent) 

 

 

 

http://en.wikipedia.org/wiki/Call_centre


Features 
Easy Installation of the client applications: after downloading, installation takes only a few minute. Installation is just as simple 
as any other windows program: next next next finish. No other configuration is required by default. 
Automatic Call Distribution: simple automatic dialing, power dialing, predictive dialing, predictive intelligent dialing 
Call Recoding: all calls can be recorded and stored  
Real time call check out: supervisors can listen to the ongoing calls real time 
Customizable Scripts: script tree, with any number of branches, answers, and reason codes. 
Customizable GUI: MAgent GUI can be completely designed from MizuManage 
Customizable IVR: any number of languages, any number of branches, call transfers to the operators 
Statistic generation: customer statistics, operator statistics, call related statistics, work time statistics, campaign statistics 
Invitation letter: customization and automatic printing 
Virtual CallCenter: more server on the same hardware (completely separated software and database) 
Works from behind firewalls with dynamic IP addresses: the client doesn't require public IP addresses 
Automatic dialing: The operator doesn't have to press a button for dialing, it is all automatic 
Database dialing: The operator can search in the database (by address, name, age etc.) and with pressing just one button, the 
operator can call back his client. 
Manual dialing: with this feature the operator can dial anybody by his number, if she/he is allowed to do so. 
Callbacks can be scheduled: the operator can create a callback if the client requires so.  
Automatic Call Distributor on the callcenter server will place the calls, as many times and intervals, as it is configured. 

Install 
Follow the Mizu VoIP Server tutorial to install the service. The only difference is that you must enable the Callcenter IN and 
OUT modules in the Configuration Wizard (this can be enabled also anytime later after the install from the MizuManage 
application -> Tools menu -> Server setup). 
In addition you will have to install the MAgent or MAgentLight application for each desktop used by the operators (these are 
native Windows applications but have been tested and works also under Linux by Wine). 

Workflow 
 System administrators will create the proper VoIP setup (peers, routing and other settings) and will monitor the 

softswitch (failed routes, etc) 
 Callcenter supervisors will add the agent users, create campaigns, scripts, GUI and watch callcenter statistics 
 Agents will use the MAgent application to perform their work (or the MAgentLight if a third party CRM is used) 

 
 Calls can be initiated by three ways (configurable globally or by campaign): 

1. predictive dialer by the server 
2. automatic calls from the MAgent Questionnaire form 
3. manual calls (from the “Calls from database” or “Manual call” form) 

 

Software components 

Application Server 

The callcenter server is completely integrated with our softswitch server platform.  
Minimum requirements with 50 agents: Windows 2003 or 2008, 1 GB RAM, Dual Core CPU, 20 GB HDD 
The server is handling the calls coming from the MAgents, MAgent will query the server for phone numbers to call or the calls 
are initiated from the predictive dialer and dropped to the MAgents when they are already connected. 
The Callcenter Out module must be enabled (can be enabled from the configuration wizard) 

Database 

The database backend is used to store CDR records, user tables and other data. 
Minimum requirements with 50 agents: MSSQL 2005 or 2008, 2 GB RAM, Dual Core CPU, 128 GB HDD. 
For simple usage there is no any skills required but for advanced usage you might need some basic SQL knowledge.  
The most important callcenter specific tables are: 
tb_cclient: usually a large table containing all the available clients (phone number, name, address and other details) 
tb_cccampaigns: contain our campaign settings (campaign name, settings) 

http://www.mizu-voip.com/Portals/0/Files/mizu_voip_server_tutorial.pdf


tb_ccampain_clients: each campaign has its own assigned clients. The applications are working mainly with this table. Here we 
store the data for clients related to a campaign. For example the number of call attempts, whether we have successfully sold 
something for the client, data that the operators will enter from MizuManage, and other details.  
tb_ccscripts: script workflow 
tb_ccscript_answers: data selected or entered by the operators while navigation trough the script 
tb_gui: each campaign can present a separate interface in the MAgent application 

MizuManage 

Application used by the administrators and supervisors to setup and monitor the campaigns (scripts, GUI builder, MAgent 
settings, client database, assign clients to campaigns, statistics, etc) 

MAgent 

Application used by the agents (operators) to make or receive calls and load and enter data from/to the database. This is 
basically a VOIP client and a CRM frontend coupled in one application. 
On the first login the database IP, port, username and password is required. This can be saved and on subsequent logins only 
the agent username and password is required.  
Form the MAgent the agents are able to do the following tasks: 
-Login/Logoff (File menu) 
-Change their own campaign (if allowed)  
Make calls: 
-By running the Questionnaire form (this is the most important form. Most of the activity should be done from here and its GUI 
and script can be built by the supervisors from the MizuManage application) 
-Call from database (if allowed). Users can search and select a client and call directly from here. 
-Manual call: is like a softphone with basic call control functions 
During calls they can select various actions (Actions menu) like Hold DTMF or call transfer. 
Agent also can see their own statistics (from the Data menu) or setup MAgent preferences (from the Tools menu) 

MAgentLight 

You might choose to use our advanced softswitch platform with your old CRM. In this case you can use the MAgentLight 
application to automate some tasks.  
Can be used to monitor call center call status and perform automatic CRM requests. For this a separate VoIP phone and a 
separate CRM frontend must be used (preferably a web based frontend so it can be controlled by the application) 
The only disadvantage is that your clients database will be duplicated (stored in your CRM, but you need to also import them to 
the Mizu platform  –tb_cclient database table) 
 

Basic settings 
To be able to use the callcenter functionality, these modules must be enabled first on the server side. For this you can use the 
Configuration Wizard from MManage (Tools menu -> Server setup) and make sure that the Callcenter In and Out modules are 
enabled (check if your license allows this, otherwise enabling the modules will not have any effect). If the callcenter modules 
are enabled then you are allowed to setup some basic settings directly from the wizard (“Callcenter” and “Predictive dialer” 
pages). There are many other options that can be set on system level using the “Configuration” form (select “callcenter” in the 
Category Filter) 
 
Incoming calls can be handled in many different ways: 

 route the call normally to the called number 
 route incoming calls to agents  (or to a group of agents) 
 a special “Callback” number can be specified and incoming calls can be treated after the configuration (route to free 

operator, or route to a predefined number) 
 handle the incoming calls by an IVR 

Incoming unknown numbers can be automatically stored into the database and a scheduled callback can be initiated 
automatically and assigned to a free operator. 
For maximum performance, you can also restrict the max ring-time and the work-time allowed for the operators between two 
calls (administrative tasks in the CRM). When the timeout will elapse, the next call will be initiated automatically without any 
interaction needed from the agent. You can also define how much time the system will recall a client and what is the minimum 
interval between two recalls. These recalls are for the not connected or failed calls, but agent are allowed to create manual 
recalls if further discussion with a client is required. 



Outgoing campaigns 
You will have to walk through the following config option to setup your callcenter: 

1. Call Routing 

Here you have to do exactly the same steps like for the VoIP softswitch. Follow the Routing and the Admin Guide. 

2. Script 

The script is a convenient way to “drive” your operators trough your business logic. For simple campaign there is no need for a 
script, but if agents have to ask many questions than the script can ease their work. 
For this you will have to use the “Scripts” form from the MizuManage application. Add a new script or modify an existing one. 
Please note, that there are 2 types of scripts: IVR scripts (used by the server for incoming IVR calls) and client side scripts. Don’t 
use server side actions in client side scripts! 

3. GUI 

Use the “GUI designer” form for this task. Even if you don’t create any customized GUI, the default GUI will be loaded. On the 
GUI you should put only the most common fields that should be visible for the agent all the time (like the name of the 
campaign, the called phone number and any other field that is important for your activity) 

4. Campaign 

Use the “Campaigns” form: click on the + sign to add a new record. Set any name then associate it with a script and a GUI and 
set its type to “Callcenter  (OUT)”. The rest of the fields are optional. 

5. Operators 

From the “Users and devices” form you need to add your agents with user type set as “Operator”. These users are like 
“Endusers” with a few callcenter specific settings. The most important fields here are the “username” which must be a unique 
string, the password and the campaign where the operator is assigned. 

6. Clients 

Clients are actually the phone numbers the agents have to call and they are stored in the tb_cclient table. 
Use the “Clients” form to add clients and put it in campaigns.  
Users can be inserted in the following ways: 

 manually from the Client form 
 import Clients button (Client form -> operations) 
 using the Export/Import wizard from the File menu 
 working directly with the database (use the SQL Server Management Studio) 

 
On the client form you can perform various filtering, the on the “Operations” form you can assign the listed record to a 
campaign. 
 
Also from this form you can view details about each user together with campaign activity (how many times it was called, when 
it was called last time, if the “offer” was “accepted” or “rejected” and other details) 

7. MAgent 

After the operator will login to the MManage application and open the  “Questionnaire” they will see the GUI and Script you 
have previously assigned for the campaign and the calls are started automatically (by the MAgent application or by the server 
side predictive dialer) 

8. Quotas 

This module have to be used only if you need to build representative statistics or you need to target different type of users 
with different campaigns.  

9. Presentation and checklists 

These modules have been built for the specific need for invitation based campaigns. (When clients are invited to an event and 
you can track the locations and invitations using these two form) 

10. Monitoring 

Use the “Callcenter statistics” form to monitor the callcenter activity. Statistics are available for campaigns and agents with 
different grouping or time interval. 



Any custom statistics can be easily written in SQL and stored in the “Direct Query” form for quick access. 
Agent will be able to see their own statistics using the MAgent application. 
Additionally a call history can be queried for each client (phone number) using the “Client History” form or by operators from 
the MAgent (only their own clients) 
 

Technical details 
The tb_cclient table is usually a huge table which contains all clients with one or more assigned phone numbers and optionally 
other client specific details like name, address, age, etc. You can create any new field in this table specific to your needs.  
After you have imported your clients to this table, you can make various filtering on it and assign a part of them to a specific 
campaign. For this the tb_ccampaign_clients table is used. All campaign specific fields should be in this table and client related 
permanent fields in tb_cclient table. 
 
You can put any field from the tb_cclient or tb_ccampaign_clients directly to the MAgent Questionnaire form to be accessible 
by operators (read/write or read-only) with the GUI designer or the script editor. Fields can be changed also from the script 
automatically (by using SQL update actions) 
 
Whether you use the automatic dialer functionality of the MAgent or the predictive dialer, the next client to be called is loaded 
from tb_ccampaign_clients table after a sophisticated algorithm which will take care for all the parameters you have defined 
on global level (Configurations form) or campaign level (Campaign form). The most important parameters are the following: 

 whether the system mobile or landline numbers are favorized (if both are set; after the first call to a client usually the 
number where we have reached it last time is favorized automatically) 

 how much times we already have called the client and when was the last call 
 whether we have to redial the client (redial set by the agents) 
 whether the recalls can be assigned to any agent or only for the agent who made the previous call (or first we try the 

original agent, then after some time the client can be assigned to any other agent  -for example if the original agent is 
not working for the company anymore) 

 any quota you have define on the Quotas form 
 client call order (random, database order, etc) 
 any other configuration parameter you have specified 

 
Clients can also be marked as “robinson”. This means that a certain client doesn’t tolerate callcenter disturbs and the system 
will mark them to be not recalled anymore. 
 
If calls are initiated by the predictive dialer, the agent will get only connected call (the drawback is that they will hear only a 
short beep instead of the ringtone and then they have to answer immediately) 
The predictive dialer is based on sophisticated statistics history to determine when and how much call it should initiate. This is 
depending on the number of agent, number of current calls, number of previous calls, ASR, ACD in the last 10 minute/last 
hour/last day/last month in a weighted calculation, max ring time and wait time settings and all other predictive dialer settings 
you set. The purpose to reduce operator wait time to minimum with minimal over dialing (when the call is connected but there 
is no free operator anymore). The more operators you have, the better the predictive dialer will work. 
 
The result of a call and the related statistics can be achieved by the following ways: 

 Using completed/accepted/rejected. This is the most easiest and convenient way to store the call result and can be 
done by using the accept and reject scrip actions or directly from the GUI (reject button for quick access). You can also 
mark one script action to be the “competition question” which means that the conversation has arrived to a point 
when we can say that it was completed. (for example the call was not rejected immediately by the called party) This 
can be the same or different from the “accepted” action)   
For this you have built-in statistics in the MManage application. 

 On the Script form you can find a special field named “endcode”. In some items you can fill this value and that will 
mean the degree in the script until the conversation has arrived. You can make any further query based on this field 
(tb_ccscript_processing.endcode) 

 Using fields from tb_ccampaign_clients to store the result. For example if you sell products, you can store the 
purchased product name in a separate field then you can make your reports and statistics based on this field (if empty 
there was not product sold …means a “failed” call) 



 Using tb_ccscript_processing table: each script item accessed by the agent can be stored in this table 
(“ivr_storecscriptanswers” global config option) and queried after your needs. This will offer the most details with the 
cost of more space and processing resources needed. 

 Using your own table(s) and field(s). You can add any new table to the database and store the important results in this 
table instead of using the built-in tables. 

 You can also use any combination of the previous methods to achieve your business goals. For example the most 
important statistics can be built after the accepted/rejected flag but if more detailed statistics are needed you will be 
able to use the other methods anytime. 

 

Test 
You can launch a campaign in test mode. For this go to the campaign settings (Details page) and select the “Test” checkbox. 
This means that the numbers in the campaign will be called in an endless loop (will be reset after all numbers are already 
called). For example you can add a few test number is this campaign and launch one or more MAgent to call these numbers. 
Never enable this option for live campaigns (because important data is lost when the reset is made). 
 
Another test option is to test your GUI and script without eventually to make an outgoing call. For this you have to select the 
“Test” option on the MAgent login form. 
 

Incoming campaigns 
This is documented in the IVR guide. The basic steps are the followings: 

 
1. Setup proper call handling and routing (Traffic senders, SIP servers, Routing) 
2. Create a IVR (IVR form) 
3. Make a campaign and assign the existing IVR for it (Campaigns form) 
4. Create an IVR users and assign the IVR for it (Users and Devices form) 
5. Create operators and assign some operators to this campaign (Users and Devices form) 
6. Operators now can launch the client application and wait for incoming calls (MAgent) 

 
 
 
 
 
For more details use the Admin Guide or contact our support. 
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